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1. Vigtigt

Denne elektroniske brugervejledning er
beregnet til alle, der bruger Philips-skeermen.
Tag den tid du behgver for at leese vejledningen,
inden du bruger skaermen. Den indeholder
vigtige oplysninger om bemarkninger angdende
brugen af din skarm.

Philips garanti daekker under forudsatning af,

at produktet behandles korrekt og anvendes til
det tilsigtede formal i overensstemmelse med
dens brugervejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kebsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og
vedligeholdelse

O Advarsler

Anvendelse af betjeningselementer; justeringer
eller fremgangsmader, der ikke er beskrevet i
denne dokumentation, kan resultere i elektrisk
sted, elektriske ulykker og/eller mekaniske
ulykker:

Lees og felg disse vejledninger, nar du tilslutter
og anvender din computerskarm.

Betjening

* Hold venligst skeermen veek fra direkte
sollys, meget steaerkt og lyst lys samt fra alle
varmekilder. Laengere tids udseettelse for
sadan et miljg kan resultere i misfarvning
og skade pa skeermen.

* Fjern alt, der kan risikere at falde i
ventilationsabningerne eller forhindre
korrekt afkgling af skeermens’ elektronik.

* Bloker ikke ventilationsdbningerne pa
kabinettet.

* Under placering af skeermen skal du sikre
dig, at det er let at komme til stremstikket
og stikkontakten.

* Hvis der slukkes for skeermen ved at fjerne

stremkablet eller jeevnstremsledningen,
skal du vente 6 sekunder, for du setter

stremkablet eller jeevnstrgmsledningen til
igen for at opnd normal betjening.

* Brug altid et godkendt strgmkabel, der
er leveret af Philips. Hvis du mangler dit
stremkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

*  Udset ikke skaermen for kraftige
vibrationer eller stad under anvendelse.

*  Sld ikke pa skeermen, og undga at tabe den
under brug eller transport.

Vedligeholdelse

* Som en beskyttelse af skeermen skal du
undga at trykke kraftigt pa LCD skeermen.
Nar du flytter din skeerm, sa tag fat
om rammen for at lgfte den. Laft ikke
skaermen ved at sette din hand eller fingre
pa LCD skarmen.

* Tag stikket ud fra skeermen, hvis du ikke
skal bruge den i en lengere periode.

* Tag stikket ud at kontakten til skaermen,
hvis du skal renggre den med en let fugtet
klud. Skeermen kan terres af med en ter
klud, nar der er slukket for strammen.
Under alle omstaendigheder; ma der ikke
bruges organiske oplasningsmidler til
rengering af din skaerm.

» For at undga risiko for elektrisk sted eller
permanent beskadigelse af anlaegget, ma du
ikke udszette skeermen for stev, regn, vand
eller miljger med hgj fugtighed.

*  Huvis din skaam bliver vad, skal den tarres af
med en ter klud sa hurtigt som muligt.

e Hvis der kommer fremmed substans eller
vand ind | skeermen, sa sluk straks for
stremmen og tag stikker ud. Fjern derefter
den fremmede substans eller vandet, og
send skarmen til servicecenteret.

e Skermen ma ikke bruges eller opbevares pa
steder; hvor den udsattes for varme, direkte
sollys eller ekstrem kulde.

* Forat opretholde den bedste ydelse
af din skeerm og for langvarig brug,
bedes du bruge skeermen et sted, der



er indenfor fzlgende temperatur- og
fugtighedsomrade.
e Temperatur: 0-40°C 32-95°F
» Fugtighed: 20-80 % RH

*  VIGTIGT: Serg altid for at aktivere
en pauseskeerm, der beveeger sig, nar
skaermen efterlades uden at blive anvendt.
Du skal altid bruge en pauseskeerm
eller et andet program, der opdaterer
skeermen regelmeessigt, hvis skeermen
viser statisk materiale i leengere perioder.
Uafbrudt visning af et stilbillede over
lengere tid, kan fordrsage “brandmeerker”,
ogsa kendt som “efterbilleder” eller
“spegelsesbilleder” pa skaermen.

“Braendmaerker”, “efterbilleder”, og
“spegelsesbilleder” er et velkendt
feenomen i LCD skaermteknologi. | de
fleste tilfelde vil “brandmeerkerne” eller
“efterbilledet” eller “spagelsesbilledet”
forsvinde gradvist, efter skaermen er
blevet slukket.

O Advarsel

Alvorlig “brandmeerkerne’- eller “efterbillede’-
eller “spagelsesbillede”-symptomer forsvinder
ikke og kan ikke repareres. Ovennavnte skade
er ikke daekket af garantien.

Service
e Kabinettet ma kun dbnes af kvalificeret
servicepersonale.

* Huvis der er behov for et dokument til
reparation eller integration, sa kontakt
dit lokale servicecenter. (Se kapitel om
“Kundeinformationscenter’)

* For oplysninger om transport, se
“Tekniske specifikationer”.

» Efterlad ikke din skeerm i en bil/bagagerum
under direkte sollys.

@ Bemaerk

Kontakt en servicetekniker; hvis skaeermen ikke
fungerer korrekt, eller hvis du er usikker pa,
hvad du skal gare, ndr betjeningsinstruktionerne,
der er givet i denne manual, er fulgt.

1.2 Notationsbeskrivelser

Felgende underafsnit beskriver de
notationsmaessige konventioner, der benyttes i
dette dokument.

Bemarkninger, forholdssregler og advarsler

I hele denne vejledning kan tekstafsnit veere
ledsaget af et ikon, og sta med fed eller kursiv
skrift. Disse afsnit indeholder bemaerkninger og
punkter, hvor der skal udvises forsigtighed, eller
advarsler: De anvendes som fglger:

& Bemark

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan gere bedre brug af
computersystemet.

0 Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab
af data.

O Advarsel
Dette ikon angiver risiko for personskader; og
hvordan dette undgas.

Visse advarsler kan optreede i andre formater,
og er eventuelt ikke ledsaget af et ikon. |
sadanne tilfelde er den givne udformning af
advarslen lovmaessigt obligatorisk.



1.3 Bortskaffelse af produkt og
emballage

Elskrot WEEE (Waste Electrical and Electronic
Equipment)

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations
on how to dispose of your old monitor and
packing from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/
sustainability/recycling.



2 Opszetning af skeer'm Bl Installation af stander

1. Anbring skeermen med forsiden vendt
nedad pa en bled og jeevn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skaermen.

2.1 Installation

1] Emballagens indhold 2. Fastger fodsgjlen pa skeermen, sa den laser

sig selv pa plads.
Quick %
Start

PHILIPS

w

Hold pa skeermens stander med begge
hander, og st med en fast hand standeren
ind i fodsgjlen.

VGA (valgfri) DVI (valgfri)



E Tilslutning il PC

PHILIPS

© AC stromindgang

© VGA-indgang

© DVI-D-indgang (tilgaengelig pa udvalgte
modeller)

O Lyd-indgang (tilgeengelig pa udvalgte
modeller)

© Kensington anti-tyverisikring

Tilslutning til pc

1. Tilslut ledningen ordentligt pa bagsiden af
skaermen.

2. Sluk for computeren og tag netledningen
ud af stikket.

3. Slut skaermens signalkabel til videostikket
bag pa computeren.

4. Sat computerens og skeermens
netledninger til et stik i neerheden.

5. Teend for computeren og skaermen. Hvis
skeermen viser et billede, er installationen
gennemfert.

2.2 Brug af skaerm

El Produktbeskrivelse set forfra

PHILPS. 00900

1L

Model 196V3LA:

(5]
AUTO/ W 1J/A 0/ 4 /0K 0}
© © 6o o o
Model 196V3L:
(5]
aTo/Vv /A /4 /0K [0)
6o 6 66 6 o
@ (O |Tander og slukker for skermen.
Sédan far du adgang til OSD-
0 =)/0K Meuen

Bekreeft justering af
skeermmenuen.

Ga tilbage til det forrige OSD-

o < niveau.

O | O |Justerer lysstryken.

© | A V¥V [Tiljustering i skeermmenuen.
1 |Juster lydstyrken.

4 Of |Skifter skeermformat.

©@ | AUTO |Juster skaermen automatisk.




Bl Beskrivelse af OSD-visningen OSD-menuen

. Nedenstdende er en generel oversigt over
R ?
Hvad er OSD (On-Screen Display)? strukturen i OSD-displayet. Du kan anvende

Visning pd skeermen [On-Screen Display den som opslag, ndr du senere skal orientere
(OSD)] er en funktion pd alle Philips LCD dig i de forskellige justeringer.
skeerme. Den szetter en slutbruger i stand .
. . : . Main menu Sub menu
til at justere skaermindstillingerne, eller
valge skaermens funktioner direkte via et
instruktionsvindue pa skeermen. Et brugervenligt Input [ VGA
skeermvisningsinterface vises som nedenfor: DVI
Model 196V3LA: (available for selective models)
Picture Format — Wide Screen, 4:3
— Picture
Brightness — 0~100
Contrast — 0~100
SmartContrast —— On, Off
Stand-Alone — On, Off
I— Audio [
Mute — On, Off

(available for selective models)

Color Temperature — 6500K, 9300K
— Color
sRGB
User Define Red: 0~100
Green: 0~100
Blue: 0~100
— Language — English, Espafiol, Frangais, Deutsch, Italiano,

Portugués, Pycckuin, EIRHL, Tirkge

— Horizontal — 0~100
— OSD Settings
— Vertical — 0~100
— Transparency — Off,1,2,3,4
ure Form - Wide Screen
rightness < LN o — OSD Time Out — 55, 10s, 20s, 30s, 60s
Contra < 50
tContrast < of L Setup — Auto
— H. Position — 0~100
— V. Position — 0~100
[ Phase — 0~100
— Clock — 0~100
— Resolution Notification — On, Off
Grundlzggende og enkle anvisninger til | Reer e
kontrolknapperne
L— Information

| skeermmenuen ovenfor, kan du bruge

V¥ A knapperne foran pd skeermen til at flytte
markgren med, og tryk pa OK knappen, til at
bekreefte dit valg eller eendring.



El Meddelelse om oplesning

Denne skaerm er fremstillet til optimal ydelse pa
dens native opl@sning, som er 1366 x 768 @ 60
Hz. Nar skeermen bruger en anden oplasning,
ses fglgende advarsel pa skeermen: Brug 1366 x
768 @ 60 Hz for at opna det bedste resultat.

Advarslen vedrgrende den naturlige oplasning
kan deaktiveres under Setup (Installation) i
OSD (skaermmenuen).

a Fysisk funktion
Vip

2.3 Fjern standeren og foden

Kl Fijernelse af foden

Inden du begynder at adskille skeermens fod,
skal du felge vejledningerne nedenfor for at
undga mulig beskadigelse eller personskade.

1. Anbring skeermen med forsiden vendt
nedad pa en jaevn overflade, og veer
forsigtig med ikke at ridse eller beskadige
skaermen.

2. Tryk pa laseklemmerne for at fierne foden
fra sgjlen.




2] Fjernelse af foden

Du kan bruge en almindelig skruetraekker
til at stikke ind i de to frigivelseshuller pa
hangslet, og lirk forsigtigt i haengseldeekslet
for at fierne det.

RN

2. Fjern de 4 skruer og fiern derefter foden
fra skaermen.




3. Billedoptimering

3.1 SmartContrast

Bl Hvad er dette?

Unik teknologi, der dynamisk analyserer det
viste indhold, og automatisk optimerer LCD
skaermens kontrastforhold til maksimal visuel
klarhed. Den gger baggrundsbelysningen og
giver et klarere, friskere og lysere billede eller
deemper baggrundsbelysningen med henblik
pa en tydelig visning af billeder pd en merk
baggrund.

B Hvorfor behaver jeg det?

Du gnsker den allerbedste visuelle klarhed
og visning pa enhvert indhold. Smart-kontrast
styrer den dynamiske kontrast og indstiller
baggrundslyset, sa det giver klare, friske og
lyse spil- og videobilleder, samt viser en
tydelig, leesbar tekst ved kontorarbejde.Ved at
nedsztte skeermens stremforbrug, sparer du
energiomkostninger og forlenger skaermens
levetid.

El Hvordan virker det?

Nar du aktiverer SmartContrast, analyseres

det viste indhold i realtid, og farver og
baggrundslysets intensitet indstilles. Denne
funktion forbedrer den dynamiske kontrast og
giver sdledes en bedre underholdningsoplevelse,
nar du ser videoer eller spiller spil.

3.2 Philips SmartControl Lite

Det nye SmartControl Lite-software fra Phillips
giver dig mulighed for at kontrollere skaermen
via et nemt, grafisk interface. Komplicerede
justeringer hegrer fortiden til. Dette
brugervenlige software guider dig gennem
finindstilling af oplgsning, kalibrering af farve,
justering af clockning/fase, RGB-hvidpunkt osv.

Dette igjefaldende, ikon-baseret software er

udstyret med den seneste teknologi i algoritmer

for hurtig behandling og reaktion, og er tilmed

Windows 7 kompatibel, og klar til at forbedre
din oplevelse med Philips-skaermel!

Kl installation

* Felg instruktionen og fuldfer installationen.
¢ Du kan starte, nar installationen er fuldfart.
*  Hvis du vil begynde senere, kan du klikke

pa genvejen pa skrivebordet eller pa
veerktgjslinjen.

PHILIPS s g e aicerr
Monitar driver and seftwars installation

Opstartsguide

* Efter installation af SmartControl Lite
starter Wizard (guiden) automatisk, nar du
dbner programmet fgrste gang.

*  Guiden leder dig trin for trin gennem
indstillingen af skeermen.

*  Du kan ogsa ga til Plug-in menuen, for at
starte guiden pa et senere tidspunkt.

* | Standard-vinduet kan du indstille flere
funktioner uden brug af guiden.
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Bl Start med Standard-vinduet:

Adjust menu (Indstillingsmenu):
*  Med Adjust Menu (Indstillingsmenuen)
kan du indstille Brightness (Lysstyrken),
Contrast (Kontrast), Focus (Fokus), Position
(Position) og Resolution (Oplgsning).
* Udfer indstillingen ved at folge
instruktionerne.
* Installationen kan annulleres med Cancel
(Annuller).
[ et 3- g 191 (CS3ETLS0000M) (X
SmartControl Lite

Brighiness

Acht 4
Brghimen
oo ” ----- e
@

10

sqad

[ per—

SmartControl Lite

el

Cxpions

L

=7

[~ p—

SmartControl Lite

[ peere—

SmartControl Lite

w8

Pl Tl (e ) (Eh
PHILIPS

Contrast

ConErast (ubs T siee] 10 kees detal

PHILIPS

Focus

22901 (rxs6713000001) (T}
PHILIPS

Position

* 124 Posmon




W stz

SmartControl Lite

L
& -
- I

*

3Pl 2230 (rxseizoe0) (DR

PHILIPS

Color menu (Farvemenu):

*  Med Color Menu (Farvemenuen) kan du
indstille RGB, Black Level (Sortniveau),
White Point (Hvidpunkt), Color Calibration

(farvekalibrering).

» Udfer indstillingen ved at folge

instruktionerne.

* Se nedenstdende oversigt med
undermenupunkter baseret pa din

indtastning.

*  Eksempel pa Color Calibration

(farvekalibrering):

[ e

SmartControl Lite

$EAE
o=

PHILIPS

Black Level

"

[ powr,

SmartControl Lite

-
=

! ;h §Q§i =

=
s ap
wrtirae
=37
B stiome

SmartControl Lite

=

B e

[S-ervi
L
Coeaton

&

Swtiuge

side

| B

SmartControl Lite

L

8 g aﬁ £

3- i 2230 (rsaeisoneenn) (TR
PHILIPS

White Point
whate Poan

2- i 7250 cxis00800s) X
PHILIPS

Display Gamama

iy st

3- P 2201 et soneont) (DX
PHILIPS

Calibration

S n =

Gk Vi



“Show Me” (Vis Mig) starter vejledningen til
farvekalibrering.

Start — starter en 6-trins
farvekalibreringssekvens.

Quick View (Hurtigvisning) indleeser fer/
efter-billederne.

For at vende tilbage til Color (Farve)
vinduet, skal du klikke pa Cancel (Annuller).

Enable color calibration (Aktiver
farvekalibrering) - der som standard er
aktiveret. Hvis markeringen er fiernet, kan
du ikke udfere en farvekalibrering, ligesom
start- og quick-visning knapperne er
gratonede.

Der skal veere patentoplysninger pa
kalibreringsskaermen.

Forste farvekalibreringsskeaerm:

Previous (Foregdende) knappen er
deaktiveret, indtil du gar videre til den
anden farveskarm.

Next (Naste) gar til efterfalgende mal
(seks mal).

Ga til sidst til File > Presets (File > Forvalg)
vinduet.

Cancel (Annuller) lukker Ul og vender
tilbage til plug in siden.

12

Options > Preferences (Funktioner >
Indstillinger) - er kun aktiv, nar Preferences
(Indstillinger) er valgt i Preferences (Funktioner)-
rullemenuen. Pa en ikke-understattet skeerm
med DDC/CI er kun Help (Hjalp) og Options
(Funktioner) til radighed.

[ r— 3 - P 22591 [EE38115

001] (X

SmartControl Lite PHILIPS

Preferences.

3

* Viser nuvarende, foretrukne indstillinger.

*  Funktionen aktiveres ved at afmaerke feltet.
Afmarkningsfeltet er en flip-flop.

* Enable Context Menu (Aktivér Indhold
menuen) er som standard afmarket
(Til) pa skrivebordet. Enable Context
Menu (Aktivér Indhold menuen) viser
valgmulighederne i SmartControl Lite
pa Select Preset (Velg Forvalg) og Tune
Display (Indstil Display) i genvejmenuen
ved at hgjreklikke pa skrivebordet. Disabled
(Deaktiveret) fierner SmartControl Lite fra
genvejsmenuen.

* Enable Task Tray (Aktiver Jobbakke)
menuen er som standard afmarket
(Til) pa skrivebordet. Enable Context
Menu (Aktivér Indhold menuen) ger, at
systembakkens ikon til SmartControl Lite
vises. Et hgjreklik pd jobbakke-ikonen
viser menufunktionerne for Help (Hjelp),
Technical Support (Teknisk Support), Check
for Update (Tjek for opdateringer), About
(Om) og Exit (Afslut). Nar Enable Task Tray
(Aktiver Jobbakke) menuen er deaktiveret,
viser jobbakke-ikonen kun EXIT (AFSLUT).



*  Run at Startup (Ker ved opstart) er Options > Audio (Funktioner > Lyd) - er
som standard afmaerket (Til). Nar den kun aktiv, nar Audio (Lyd) er valgt i Options
er deaktiveret, starter SmartControl Lite (Funktioner) rullemenuen.
ikke ved opstart og ikonet vises ikke i
systembakken. SmartControl Lite kan
kun startes fra genvejen pa skrivebordet

Pa en ikke-understattet skeerm med DDC/CI
er kun Help (Hjzelp) og Options (Funktioner) til

eller fra programfilen. Intet forvalg, som er radighed.

indstillet til at kere ved opstart, indleses Lo S
nar denne boks ikke er afmarket (er SmartControl Lite PHILIPS
deaktiveret). Audia

* Enable transparency mode (Aktivér

gennemsigtighedstilstand) (Windows u
7,Vista, XP). Standard er 0% Q
uigennemsigtighed. \ x
Options > Input (Funktioner > Indgang) 5 o
- er kun aktiv, nar Input (Indgang) er valgt i \g L
Options (Funktioner) rullemenuen. Pa en ikke- = g

understgttet skeerm med DDC/CI er kun Help
(Hjeelp) og Options (Funktioner) til radighed.

&

Alle andre faneblade i SmartControl Lite er ikke = 5 "
til radighed.
[ pe— 3 - Pl 1138 T
SmartControl Lite PHILIPS Help > User Manual (Hj=lp >
- Brugervejledning) - er kun aktiv, nar User
o Manual (Brugervejledning) er valgt i Help
Lo et s o v e (Hjzelp) rullemenuen. P4 en ikke-understattet
= 2 e e o skeerm med DDC/Cl er kun Help (Hjelp) og
oy o D Options (Funktioner) til radighed.
P L]
G .
el - SmartControl Lite PHILIPS
k - User Manual
E— Prusee Ak e b, Bt S
=

e o) \g

* Vis Source (Kilde) instruktionsvinduet og

&
timinfe M

nuvaerende indgangskildeindstillinger. \@
* P4 enkeltindgangsskeerme ses dette vindue i
ikke. \g

13



Help > Version (Hjlp > Version) - er kun aktiy,
narVersion (Version) er valgt i Help (Hjeelp)
rullemenuen. Pd en ikke-understgttet skaerm
med DDC/Cl er kun Help (Hjzelp) og Options
(Funktioner) til radighed.

[ a3 1) (i
SmartControl Lite PHILIPS

Version

Context Sensitive (Indholdssensitiv) menuen

Context Sensitive (Indholdssensitiv) menuen
er som standard aktiveret. Hvis Enable Context
(Aktiver Indholdssensitiv) menuen er afmeerket
i Options > Preferences (Funktioner >
Indstillinger) vinduet, ses menuen.

ml  F [

B SmartControl
Helect Preset L3
Tune Display

”Context” (Indhold) menuen har tre punkter:

* SmartControl Lite - nar valgt, ses About
(Om) skaermen.

»  Select Preset (Valg Forvalgt) — herefter
vises en hierakisk menu med gemte forvalg,
der straks kan bruges. En afkrydsning viser
det nuveerende valgte forvalg. Factory
Preset (Fabriksforvalg) kan ogsa hentes i
rullemenuen.

* Tune Display (Indstil Skaerm) - abner
kontrolpanelet til SmartControl Lite.

Task Tray (Jobbakke) menu aktiveret
Menuen i systembakken kan ses ved at
hejreklikke pa SmartControl Lite-ikonet
i systembakken. Et venstreklik starter
programmet.

Help

Technical Support
Check for Update
About

Exk

Jobbakken har fem punkter:

*  Help (Hjalp) - adgang til
brugervejledningsfilen: Abner User Manual
(Brugervejledningen) med standard
browservinduet.

*  Technical Support (Teknisk Support) - viser
siden med teknisk support.

»  Check for Update (Tjek for opdateringer)
- leder brugeren til PDI Landing og tjekker
brugerens version i forhold til den nyeste
version.

e About (Om) - viser detaljerede
referenceoplysninger: Produktversion,
udgivelsesinformation og produktnavn.

»  Exit (Afslut) - Luk SmartControl Lite.

Hvis du vil kere SmartControl Lite igen,

skal du enten veelge SmartControl Lite i

programmenuen, dobbeltklikke pa skrivebordet
eller genstarte systemet.

PHILIPS

‘“ersion 3.20
dune.standard SOO07-01-04-151-23
Cppright 10E3.2007 Portrat Displays, ind
Patarts Panang




Task Tray (Jobbakke) menu deaktiveret
NarTask Tray (Jobbakke) er deaktiveret i
indstillinger-mappen, er kun EXIT (AFSLUT)
valgmuligheden til radighed. Hvis du helt vil
fierne SmartControl Lite fra systembakken,

skal du deaktivere Run at Startup (Ker ved
opstart) i Options > Preferences (Muligheder >
Indstillinger).

15



4. Tekniske specifikationer

Skeermpaneltype TFI-LCD
Baggrundslys LED
Panelstarrelse 185" W (47,01cm)
Billedforhold 16:9
Pixel pitch 0,3 x 0,3 mm
Lysstyrke 250 cd/m?
Smart-kontrast 10,000,000:1
Kontrastforhold (norm.) 1000:1
Reaktionstid (norm.) 5ms
Optimal oplgsning 1366 x 768 pa 60 Hz
Synsvinkel 170° (H) / 160° (V) ved C/R > 10
Skeermfarver 16,7 M
Vertikal opdateringshastighed 56Hz - 76Hz
Horisontal frekvens 30kHz - 83kHz
sRGB JA
| Tisluwingsmuligheder ]
Inputsignal DVI (digital), VGA (Analog)
Inputsignal Separat synk, synk. pa gren
| Behagelighed ]
Brugerfunktioner 196V3LA:  auto/v /A O/4 B[k O
196V3L: auto/v /A 0:/ 4 /0K 0)
Engelsk, Fransk, Tysk, Spansk, Italiensk, Russisk,
OSD sprog Sin%pliﬁceret Kingsisk, gor‘tugisisk og Tyrkisk
Andre funktioner Kensington-las
"Plug & Play" kompatibilitet DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux
Vip -5/+20
196V3LA:
[swom ]
Teendt-tilstand 1791W (typ.), 23,26W (maks.)
AC indgangsspeen- | AC indgangsspen- | AC indgangsspaen-
Energiforbrug ding ved 100VAC ding ved 115VAC ding ved 230VAC
(EnergyStar 5.0 testmetode) +/-5VAC, 50Hz +/-5VAC, 60Hz +/-5VAC, 50Hz
+/- 3Hz +/- 3Hz +/- 3Hz
Normal funktion (norm.) 13,42W 13,32W 13,30W
| dvale (Standby) 0,5W 0,5W 0,5W
Fra 0,5W 0,5W 0,5W
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AC indgangsspeen-
ding ved 100VAC

AC indgangsspan-
ding ved 115VAC

AC indgangsspeen-
ding ved 230VAC

Varmetab* +/-5VAC, 50Hz +/-5VAC, 60Hz +/-5VAC, 50Hz +/
+/- 3Hz +/- 3Hz -3Hz

Normal drift 458 BTUt 4546 BTU/t 4539 BTU

| dvale (Standby) 1706 BTU/ 1706 BTU 1706 BTUIt

Fra 1706 BTU 1706 BTUI 1706 BTU

Stremdiode

Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)

Stremforsyning

Indbygget, 100-240VAC, 50-60Hz

196V3L:

Tendt-tilstand

17,6W (typ), 19.0W (maks.)

Energiforbrug

(EnergyStar 5.0 testmetode)

AC indgangsspeen-
ding ved 100VAC
+/-5VAC, 50Hz

AC indgangsspeaen-
ding ved 115VAC
+/-5VAC, 60Hz

AC indgangsspeen-
ding ved 230VAC
+/-5VAC, 50Hz +/

+/- 3Hz +/- 3Hz -3Hz

Normal funktion (typ.) 14,15W 14,10W 14,10W

| dvale (Standby) 0,5W 0,5W 0,5W

Fra 0,5W 0,5W 0,5W
AC indgangsspen- | AC indgangsspaen- | AC indgangsspaen-

Varmetab* ding ved 100VAC ding ved 115VAC ding ved 230VAC
+/-5VAC, 50Hz +/-5VAC, 60Hz +/-5VAC, 50Hz +/
+/- 3Hz +/- 3Hz -3Hz

Normal drift 48,29 BTU/ 48,12 BTU/ 48,12 BTU/

| dvale (Standby) 1,706 BTUA 1,706 BTUA 1,706 BTU/t

Fra 1,706 BTUA 1,706 BTU/ 1,706 BTUA

Stremdiode

Til-tilstand: Hvid, Standby-/Sove-tilstand: Hvid (blinker)

Stremforsyning

Indbygget, 100-240VAC, 50-60Hz

Produkt uden fod (B x H x D)

463 x 358 x 204 mm

Produkt uden fod (B x H x D)

463 x 284 x 44 mm

Produkt med fod 2,3%g
Produkt uden fod 2,09g
Produkt med emballage 3,38kg
Temperaturomrade (drift) 0°C til 40°C
Temperaturomrade (ikke i drift) | -20°C til 60°C

Relativ fugtighed 20% til 80%

el Betjenihg: + 3.658 m (12.000 fod)
Ikke drift: + 12192 cm (40.000 fod)

MTBF 30.000 timer
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ROHS JA
EPEAT Silver (www.epeat.net)
Emballage 100 % genbrugelig

Myndighedernes godkendelser

CE Maerket, FCC Klasse B, GOST, SEMKO, TCO Godkendt (Only
for selective models), UL/cUL, BSMI, 1SO9241-307

Farve Sort
Overflade Blank/Tekstur
@ Bemaerk
1. EPEAT Gold og Silver er kun gyldig hvor Philips registrer produktet. Besgg venligst www.epeat.net
for registreringsstatus i dit land.
2. Disse data kan &ndres uden varsel. Ga til www.philips.com/support for at hente den seneste

version af brochuren.
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4.1 Oplesning og forudindstillede
funktioner

Kl Maksimal oplasning
1366 x 768 ved 60 Hz (analogt indgang)
1366 x 768 ved 60 Hz (digital indgang)

B Anbefalet oplesning
1366 x 768 ved 60 Hz (digital indgang)

31,47 720 x 400 70,09
31,47 640 x 480 59,94
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
47,71 1366 x 768 59,79
& Bemark

Bemaerk venligst at din skaerm virker bedst med
native oplgsning pa 1366 x 768 ved 60Hz. For
at opna den bedste skeermkvalitet, bedes du
venligst bruge denne oplasning.

19



5. Stremstyring

Hvis der er installeret et skeermkort eller
software pa pc'en, der er i overensstemmelse
med VESA DPM, kan skeermen automatisk
nedsatte stromforbruget, nar den ikke bruges.
Nar input fra tastatur, mus eller anden input-
enhed registreres, "vagner" skaeermen automatisk
igen. Nedenstdende tabel viser denne
automatiske energisparefunktions stremforbrug
og signalering:

196V3LA:
VESA .
tilstand Video |V synk | L synk | Opbrugt strem | LED Farve
Aktiv T | || P EEm) ||
| dvale . ’ Hvid
Gy || T || N || MBI || <EWER) || @i
Kontakt Fra| FRA = = <05W (typ.) FRA
196V3L:
VESA .
tilstand Video |V synk | L synk | Opbrugt strem | LED Farve
Adiv | TIL | o || POV @SR ||
| dvale . . Hvid
(Standoy) | A | NeJ | Nej | <0SWER) | o
Kontakt Fra| FRA - - < 05W (typ.) FRA

Folgende opsetning bruges til at male
skeermens stremforbrug.

* Indbygget oplgsning: 1366 x 768
»  Kontrast: 50%
*  Lysstyrke: 250 nits

» Farvetemperatur: 6500k med fuldt, hvidt
mgnster

@ Bemaerk
Disse data kan andres uden varsel.
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6. Lovmassige oplysninger

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community's
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the

planet

carries the TCO Certified label.
This ensures that your display is

designed, manufactured and tested according to

some of the strictest quality and environmental

requirements in the world. This makes for a high

performance product, designed with the user

in focus that also minimizes the impact on the

climate and our natural environment.

The display you have just purchased

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.
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* Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or ISO 14001).

*  Very low energy consumption both in on-
and standby mode minimize climate impact.

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development in
co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is now
requested by users and [T-manufacturers all
over the world. About 50% of all displays world-
wide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document,Ver. 2.1

I[n Technology for you and the planet
CERTIFIED

(Only for selective models)



EPEAT

(Wwww.epeat.net)

(%  The EPEAT (Electronic
QQ Product Environmental
7 Assessment Tool) program
evaluates computer

desktops, laptops, and monitors based on 51
environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

* EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

«  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

*  EN61000-3-2:2006+A1:2009+A2:2009
(Limits for Harmonic Current Emission).
»  EN61000-3-3:2008 (Limitation of Voltage

Fluctuation and Flicker) following provisions
of directives applicable.

* 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

* 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

«  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

e GS EK1-2000:2009 (GS mark requirement).

»  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

e MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

*  TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR”
guidelines for energy efficiency.

i)

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de
I'article 15 Des regles de la FCC. Ces
limites sont concues de facon a fourir
une protection raisonnable contre les
interférences nuisibles dans le cadre d'une
installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliére. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

*  Brancher I'équipement sur un autre circuit
que celui utilisé par le récepteur

¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a l'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

“This davice belongs to catagory B devices a8 described in EN 55022, unless it is spaci-
cally stated that it i a Class A devics on the epeciication labal. The following applies to
devices in Class A of EN 55022 (radius of protection up 1o 30 metars). The user of the
davice is obligad to take all staps necessary o remove sources of interfarance to tals-
communication or other devicas.

Pokd neni na fypovém &tk potstase uvedena, # spedé do do tidy A podie EN 55022,
spada automaticky do tfidy B podle EN 55022, Pro zafizen! zafazend do tFidy A (chranné
pésma 30m) podie EN 5502 platl nésleduficl. Dojde-li k rullan! telskomunikatich nebo
finjich zafizani e uivatal povinnen provést takova opatfgni, atry nen odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so on)
should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1T-42107
and PN-89/E-06251.

Wymagania Polskiege Centrum Badan i Certyfikacji
Uzpedzenie powiano byt rasilane z paiasds 2 preylaceonym obwodem ochronmym (gnisedo
katkiem). Wapdipracuiaee 2 soby ufzadzenia (Komputer, monitor, drukarka) powinty bye msilane
& togo samego dridla
Instalacja elektrycna pomiesaczenia powinna mwie
przs zwarciami, w postaci bezpieconika o warke
W el catkowitogo wybyerenia urspdzents 2 siect zasilania, nalezy wyint wiycekg kabla
easilajacega = poazdka, kidre powinno ssidowad s w pobliz urmJJanm:I!\t Batwi dosiepne.
Znak bespieczefsrwa "B” potwierdzs 2podnosé uresdzenia » wymaganiami bezpiecsefaiwa
whytkowania awartymi w PN-93T-42107 | PN-§9E-D6;

w przeworksie fzowym rezecrowa achrang
marmienavwe] e wicksej ni 164 (amperiuw).

Pozostale instrukcje bezpieczensiwa

* Niemaledy urywad wiyceek sdapterowych lub usuwaé kolka abwedu ackrornego 2 wiyeeki.
Jekeli Lu\m‘WIILJLJ LRy |:|1:\:\Jlural‘ra o naledy whyd preediuzace 3-pylowego 2
System kmpalerowy rnlny sabezpivcryt prred nagtymi, chwilow
ac eliminatora preepied, urradrenia dopasow
berzakidceniowe irinia zasilania.

tic nie leZalo na kablach systemu kompuierowego, arz aby kable nie
dzse tokna byloby na sie nadeptywad lub poryksd sig o nie.

warostami lub spad-
X

T e p——

Nie maleiy wpychad adnych preedmiotion do atwost sy
podar lub porpenie pridem, poprzez o

najdowad sig 2 dala od g

Tacyjnych. Nakezy un

karmpuler oriz umisszezanss kamputera w ciasmym migse bez mailiwobe eyrkalac peoi-
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORGVED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTAVERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RBAZEARERZIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Réntgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerites befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Storstrahlern nach Anlage
a5 Abs. 4 der Rontgenverordnung erflillt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhéhte Augenbelastung bei zu
geringem Zeichenkontrast wéren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betragt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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7. Kundeservice og garanti

7.1 Philips' regler ved pixeldefekter
pa fladskaerme

Philips tilstreeber at levere produkter af den
hgjeste kvalitet.Vi anvender nogle af branchens
mest avancerede produktionsprocesser og
udferer en streng kvalitetskontrol. En gang
imellem er defekte pixler eller sub-pixler pa
TFT-skeerme dog uundgaelige. Ingen producent
kan garantere, at alle paneler vil veere fri for
pixeldefekter, men Philips garanterer, at enhver
skeerm med et uacceptabelt antal defekter
repareres eller udskiftes under garantien.

Dette notat forklarer de forskellige former

for pixeldefekter og definerer de acceptable
defektniveauer for hver type. For at veere
berettiget til reparation eller udskiftning under
garantien skal antallet af pixeldefekter pa en TFT
-skaerm overskride disse acceptable niveauer.
For eksempel ma hgjst 0,0004% af sub-pixlerne
pa en skeerm vare defekte. Desuden seetter
Philips endnu hgjere kvalitetsnormer pa visse
typer eller kombinationer af pixeldefekter, der er
mere generende end andre. Denne pixelpolitik
geelder i hele verden.

sub-pixler sub-pixler  sub-pixler

vy

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af
tre sub-pixler med primarfarverne rgd, gren og
bla. Nar mange pixler settes ssmmen, kan de
danne et billede. Nar alle sub-pixler i en pixel
lyser, fremstar de farvede sub-pixler tilsammen
som enkelt hvid pixel. Hvis de alle er mgrke,
fremstar de tre farvede sub-pixler tilsammen
som en enkelt sort pixel. Andre kombinationer
af oplyste og merke sub-pixler fremstdr som
enkelte pixler i andre farver

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optraeder pa
skaermen pa forskellige mader. Der er to
kategorier af pixeldefekter og flere typer sub-
pixeldefekter i hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels
eller underpixels, der altid lyser eller er “teendt’.
Det vil sige, at en lys prik er en underpixel, der
fremstar pa skeermbilledet, nar skeermen viser et
mearkt menster. Der er fglgende typer defekte
lyse prikker.

En teendt red, gron eller bld sub-pixel.

I ©

To sammenliggende tendte sub-pixler:
- Red + Bla = Lilla

- Red + Gren = Gul

- Grgn + Bla = Cyan (Lysebld)

Tre sammenliggende teendte pixler (en hvid
pixel).
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@ Bemaerk

En red eller bld lys prik skal veere mere end 50
procent lysere end de omkringliggende prikker,
mens en gron lys prik er 30 procent lysere end
de omkringliggende prikker.

Defekte morke prikker

Defekte merke prikker fremkommer som
pixels eller underpixels, der altid er merke
eller er“slukkede”. Det vil sige, at en lys prik er
en underpixel, der fremstar pa skaermbilledet,
nar skaermen viser et mgrkt menster. Der er
folgende typer defekte marke prikker.

Tetsiddende pixeldefekter

Da pixel- og sub-pixeldefekter af samme
type, der ligger teet pa hinanden, kan veere
mere igjnefaldende, specificerer Philips ogsa
tolerancer for teetsiddende pixeldefekter.

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal en TFT-skaerm i en Philips
fladskaerm have pixel- eller sub-pixeldefekter,
der overskrider de tolerancer, der er gengivet i
felgende tabeller:

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU
1 teendt sub-pixel 3

2 sammenliggende taendte sub-pixler 1

3 Tre sammenliggende taendte sub-pixler (en hvid pixel) 0

Afstand mellem to bright dot-defekter* >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER ACCEPTABELT NIVEAU
1 mark sub-pixel 5 eller feerre

2 sammenliggende mgrke sub-pixler 2 eller ferre

3 sammenliggende marke sub-pixler 0

Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller feerre
SAMLEDE DOT-DEFEKTER ACCEPTABELT NIVEAU
Samlede bright- eller black dot-defekter af alle typer 5 eller feerre

@ Bemaerk
1.
2.

1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
Denne monitor er i overensstemmelse med 1SO9241-307 (1ISO9241-307: Testmetoder for

ergonimiske kray, analyse og overensstemmelse pa elektroniske visuelle skaerme)
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7.2 Kundeservice og garanti

For oplysninger om garantidaekning og gzeldende stgttekrav i dit omrdde, bedes du besagge www.
philips.com/support website for details. Du kan ogsa kontakte dit lokale Philips kundeservicecenter via
nummeret nedenfor.

Kontaktoplysninger i Vesteuropa:

Land ASC Kundeservice tIf Pris

Germany Siemens 1&S +49 01803 386 853 €009

United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010

Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 €009

Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €008
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens &S +43 0810 000206 €007

Belgium E Care +32 078 250851 €006
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktoplysninger til CENTRAL- OG @STEUROPA:
Land Callcenter ASC

Kundeservice tif

Belarus NA IBA +37517 217 3386
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA Renoprom +385 1 333 0974
Estonia NA FUJITSU +372 6519900
Latvia NA “ServiceNet LV” Ltd. +371 7460399
Lithuania NA UAB "Servicenet" +370 7400088
Romania NA Blue Ridge Intl. +40 21 2101969
ile;:i;r%egro NA Kim Tec d.o.o. +381 11 20 70 684
Slovenia NA PC H.and +386 1 530 08 24
U NA Comel +380 562320045
NA Topaz-Service Company +38 044 245 73 31
R— NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware . +36 12426331
NA Profi Service +36 1 814 8080

Kontaktoplysninger til LATINAMERIKA:

Land Callcenter
Brazil

- Vermont
Argentina

Kundeservice tif
0800-7254101

0800 3330 856

Kontaktoplysninger til Kina:
Kina
Kundeservice tlf: 4008 800 008

Kontaktoplysninger tiil NORDAMERIKA:

Land Callcenter N e Kundeservice tlf
USA. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696




Kontaktoplysninger til APMEA:

Land

Callcenter

ASC

Kundeservice tif

Australia NA AGOS NETWORK PTY LTD | 1300 360 386
New Zealand [ NA Visual Group Ltd. 0800 657447
Hong Kong / : Hong Kong:Tel: +852 2619 9639
Macau NA Smart Pixels Technology Ltd | 1. -\ Tel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 1o 56677
. , . . . Tel: 62 21 75909053, 75909056,
Indonesia NA PT. Gadingsari elektronika Prima 7511530
South Korea | NA PCS One Korea Ltd. 080-600-6600
: After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer Care | (65) 6882 3999
Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA Axis Computer System Co,, Ltd. | (662) 934-5498
South Africa NA Sylvara Technologies Pty Ltd 086 0000 888
Jnited Arab 5 AL SHAHD COMPUTER LLL.C |00971 4 2276525
Emirates
Israel NA Eastronics LTD 1-800-567000
FPT Service Informati +84 8 38248007 Ho Chi Minh City
Vietnam NA Com va Cft g Ormatic +84 5113.562666 Danang City
By R +84 5113562666 Can tho Province
- . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d.IS'tI”IbutOI" and/or service
provider currently
Bangladesh NA Distributor: Computer Source | 880-2-9141747,9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 977-1-4222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty [ 855-023-999992

buy-out)
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8. Fejlfinding og FAQ

8.1 Fejlfinding

Denne side omhandler problemer, som kan

klares af brugeren selv. Hvis problemet stadig er

der; efter at du har prevet disse lasninger, skal
du kontakte Philips' kundeservice.

a Almindelige problemer

Intet billede (stremdiode lyser ikke)
* Kontroller, at ledningen er sat |
stikkontakten og bag pa skaermen.

*  Kontroller fgrst, at stregmkontakten foran
pa skaeermen er i OFF (FRA), og stil den
derefter pa ON (TIL).

Intet billede (stremdiode lyser hvid)
*  Kontroller, at der er teendt for computeren.

* Kontroller, at signalkablet er korrekt
forbundet til computeren.

* Kontroller, at der ikke er nogen bgjede

stikben pa signalkablets stik. Hvis der er det,

skal du fa kablet repareret eller udskiftet.

* Energisparefunktionen kan veere aktiveret

Skaerm siger

Attention

Check cable connection

* Kontroller, at signalkablet er korrekt
forbundet til computeren. (Se ogsa Quick
Start Guiden).

*  Tjek, om skeermkablets stikben er bgjede.

» Kontroller, at der er tendt for computeren.

AUTO (AUTOM.) knappen virker ikke

*  Den automatiske funktion fungerer kun i
VGA analog-tilstand. Hvis resultatet ikke er
tilfredsstillende, kan der foretages manuelle
justeringer via OSD-menuen.

32

& Bemark
Den automatiske funktion er ikke n@dvendig i
DVI digital-tilstand.

Synlige tegn pa rog eller gnister
*  Forseg ikke selv at fejlfinde

e Treek straks skeermens stik ud af
stikkontakten

»  Kontakt straks en repreesentant fra Philips
kundeafdeling.

2] Billedproblemer

Billedet er ikke centreret
* Justér billedets position med funktionen
“Auto” (Automatisk) i OSD-menuerne.

* Juster billedpositionen med Phase/Clock
(Fase/Klokke) i OSD hovedmenuen. Den
kan kun bruges i VGA-tilstand.

Billede vibrerer pa skermen
* Tjek, at signalkablet er korrekt forbundet til
grafikkortet eller pc'en.

Lodret flimren

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjeelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.

Vandret flimren

=

* Justér billedet med funktionen “Auto”
(Automatisk) i OSD-menuerne.

* Eliminer de lodrette bjelker med Phase/
Clock (Fase/Klokke) i OSD hovedmenuen.
Den kan kun bruges i VGA-tilstand.




Billedet er slgret, uklart eller for markt
* Indstil kontrasten og lysstyrken i OSD.

Der forbliver et “efterbillede”,
“brandmarkerne” eller “spogelsesbillede”,
efter at der er slukket for stremmen.

»  Uafbrudt visning af et stilbillede over
lengere tid, kan forarsage “brandmaerker”,
ogsa kendt som “efterbilleder” eller
“spogelsesbilleder” pd skaermen.
“Breendmaeerker”, “efterbilleder”, og
“spogelsesbilleder” er et velkendt feenomen
i LCD skaermteknologi. | de fleste tilfeelde vil
“brandmaerkerne” eller “efterbilledet” eller
“spogelsesbilledet” forsvinde gradvist, efter
skaermen er blevet slukket.

*  Serg altid for at aktivere en pauseskeerm,
der beveaeger sig, nar skeermen efterlades
uden at blive anvendt.

*  Du skal altid bruge en pauseskeerm eller
et andet program, der opdaterer skeermen
regelmeessigt, hvis LCD skaermen viser
statisk materiale i leengere perioder.

* Alvorlig “brandmaerkerne’- eller
“efterbillede”- eller “spagelsesbillede’-
symptomer forsvinder ikke og kan ikke
repareres. Ovennavnte skader er ikke
daekket af garantien.

Billedet er forvranget. Tekst er utydelig eller

sloret.

* Indstil pc'ens skeermoplasning som
skaermens anbefalede, native oplgsning.

Der ses rgde, bld, mgrke og hvide pletter pa

skaermen

*  De resterende prikker er normale i den
flydende krystal-teknik, der bruges i dag.
Se politikken om pixels for yderligere
oplysninger.

“Teendt” lyset er for kraftigt, og det er

forstyrrende

*  Du kan justere “Taendt” lyset med
Stremdiode i OSD-menuerne.

For yderligere hjeelp, se venligst listen over
Forbrugerinformationscentre og kontakt
Philips's Kundeservice.
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8.2 Generelle FAQ

SP1: Hvad skal jeg gore, hvis skermen under

installationen viser “Cannot display

this video mode” (Kan ikke vise denne

videotilstand)?

Sv.. Den anbefalede oplasning pa denne

skaerm: 1366 x 768 pa 60 Hz.

*  Frakobl alle kabler og forbind derefter

pc'en til skeermen, som du brugte for

* | Windows Startmenuen, vaelg Settings/
Control Panel (Indstillinger/Kontrolpanel). |
Control Panel (Kontrolpanel)-vinduet veelg
Display (Skaerm)-ikonet. | Egenskaber for
Skeerm-vinduet veelg “Settings” (Indstillinger)
fanebladet. Under indstillinger-fanen, under
feltet “desktop area" (skrivebordsomrade),
skal du stille justeringsbjaelken pa 1366x768
pixler.

+ Abn “Advanced Properties” (Avanceret) og
indstil opdateringshastigheden pa 60 Hz og
klik derefter pa OK.

* Genstart computeren og gentag trinene
2 og 3 og bekraft, at pc'en er indstillet til
1366x768 ved 60 Hz.

*  Luk for computeren, frakobl den gamle
skeerm og genforbind Philips LCD skaermen.

* Tend for skeermen og derefter for pc'en.

SP2: Hvad er den anbefalede
opdateringshastighed pa LCD skarmen?
Sv..  Den anbefalede opdateringshastighed
pa LCD skerme er 60 Hz. | tilfeelde af
forstyrrelser pa skaermen skal du sztte
den op til 75 Hz og se, om dette fierner
forstyrrelserne.

SP3: Hvad er .inf og .icm filerne pa cd-
rom'en? Hvordan installerer jeg driverne
(.inf og .icm)?

Sv.:  Dette er skeermens driverfiler: Installer
driverne i henhold til brugervejledningen.
Computeren kan bede dig om
skaermdrivere (.inf og .icm filer) eller om
en driverdisk, ndr du installerer skaermen

forste gang. Indszet (medfelgende cd-rom)



SP4:

Sv.:

SP5:

Sv.:

SPé:

Sv.:

SP7:

Sv.:

SP8
Sv.:

i pakken i henhold til vejledningerne.
Skaermdrivere (inf og .icm filer) installeres
automatisk.

Hvordan justerer jeg oplasningen?
Skaermkortet/grafikdriveren og skaeermen
bestemmer sammen oplgsningerne til
radighed. Du kan veelge den gnskede
oplasning under "“Egenskaber for Skaerm” i
Windows® kontrolpanelet.

Hvad, hvis jeg “farer vild”, mens jeg
justerer skaermen?

Sa skal du blot trykke pa OK og derefter
vaelge "Reset” (Nulstil) for at ga tilbage il
de oprindelige fabriksindstillinger.

Er LCD-skaermen modstandsdygtig
overfor ridser?

Det anbefales generelt ikke at udsatte
skaermens overflade for kraftige sted.
Den er beskyttet mod skarpe og stumpe
ting. Nar du handterer skaermen, sa

pas pa ikke at trykke for kraftigt pa
skeermens overflade. Det kan pavirke
garantibetingelserne.

Hvordan renger jeg LCD skarmens
overflade?

Til normal renggring skal du blot anvende
en ren, bled klud. Til kraftigere rengering
skal du bruge isopropylalkohol. Brug

ikke andre oplgsningsmidler sdsom
ethylalkohol, ethanol, acetone, hexan osv.

: Kan jeg ®ndre skarmens farveindstilling?

Ja, du kan andre farveindstillingen via
OSD pa felgende made:
Tryk pa “OK" for at vise OSD (On Screen
Display) menuen

Tryk pa “Down Arrow" (Ned-pil) for
at veelge indstillingen “Color” (Farve),
og tryk derefter pa “OK" for at angive
farveindstillingen. Der er tre indstillingen,
som vist nedenfor.

1. Farvetemperatur med to indstillinger;
6500K og 9300K. Med indstillinger i
6500K omradet virker skaermen “varm,
med en rgd-hvid farvetone”, mens en
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9300K temperatur giver en “kold bla-
hvid farvetone”.

2. sRGB - dette er en standardindstilling,
som sikrer korrekt udveksling af farver
mellem forskellige enheder (f.eks.
digitale kameraer, skeerme printere,
skannere osv).

3. User Define (Brugerdefineret) -
brugeren kan velge sin foretrukne
farveindstilling ved at indstille den rede,
grenne og bla farve.

& Bemerk

En malning af farven pa lys, der udstrdles fra
et objekt, mens det opvarmes. Denne maling
udtrykkes pa en absolut skala (kelvingrader).
Lavere kelvingrader sasom 2004K er rede,
hgjere temperaturer sasom 9300K er bla.
Neutral temperatur, 6504K, er hvid.

SP9: Kan jeg forbinde min LCD skaerm til
enhver pc, arbejdsstation eller Mac?

Ja. Alle Philips LCD skaerme er fuldt
kompatible med standard pc'er, Mac og
arbejdsstationer. En ledningsadapter kan
vaere ngdvendig for at kunne forbinde
skaermen til dit Mac-system.Vi anbefaler;
at du kontakter Philips salgsrepraesentant
for yderligere oplysninger:

SP10: Er Philips LCD skaerme “Plug & Play”?

Sv.:  Ja, skeermene er “Plug & Play” kompatible
med Windows 7/Vista/XP/NT, Mac OSX
og Linux

SP11: Hvad er “billedklebning” eller
“billedindbranding” eller “efterbillede”
eller “spogelsesbillede” pa LCD skarme?
Uafbrudt visning af et stilbillede over
lengere tid, kan forarsage “brandmaerker”,
ogsa kendt som “efterbilleder” eller
“spogelsesbilleder” pa skeermen.
“Breendmeerker”, “efterbilleder”, og
“spagelsesbilleder” er et velkendt
feenomen i LCD skeermteknologi. | de
fleste tilfelde vil “brandmeerkerne” eller
“efterbilledet” eller “spagelsesbilledet”

Sv.:

Sv.:



forsvinde gradvist, efter skeermen er
blevet slukket.

Serg altid for at aktivere en pauseskarm,
der bevager sig, nar skaermen efterlades
uden at blive anvendt.

Du skal altid bruge en pauseskaerm

eller et andet program, der opdaterer
skaermen regelmaessigt, hvis LCD
skeermen viser statisk materiale i leengere
perioder

O Advarsel

Alvorlig “brandmarkerne”- eller “efterbillede”-
eller “spggelsesbillede”-symptomer forsvinder
ikke og kan ikke repareres. Ovennavnte skade
er ikke deekket af garantien.

SP12: Hvorfor viser skaeermen ikke skarp tekst?

Sv.:

Hvorfor viser den forrevne tegn?

Din LCD monitor virker bedst pa dens
native oplgsning pa 1366 x 768 ved

60 Hz. Brug denne oplasning for at opna
det bedste billede.
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